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施設のルール
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装置使用の前に

以下を必ず読んで、ルールを守って使用して下さい

• 研究室内は土足厳禁、飲食厳禁

• 装置の故障、不具合を見つけたらすぐに施設職員に連絡。緊急
連絡先は研究室入口ドアの横に記載してあります

• 装置を乱暴に扱わない
• 研究室の物品を勝手に持ち出さない

• 貴重品の管理は各自でする。休日や夜間利用の際、研究室の施
錠は各自で行う

• ステージの移動操作時はチャンバー内を良く見ること。動かし過
ぎると試料がX線源などにぶつかり、故障します

• ソフトウェア、ハードウェア上のパラメータを変更した場合、装置使
用後に初期設定に戻す

• 分析装置PCに直接自分のUSBメモリを差し込まない。当研究室専
用のUSBメモリを利用し、解析用PCを経由してデータを取り出す

• 分析室内に導入するものは素手で触らない。備品を利用して汚し
た場合は自分で洗浄する

• 使用者が予約を取って、予約時間通り使用する。変更の場合は
前日までにキャンセル。当日の予約キャンセルは無効です。利用
を延長したい場合は当日に予約を追加する

• 装置利用中の故障トラブルは全て貴研究室の責任です。装置利
用について自分の指導教官に必ず知らせておくこと

• 初めて装置を使う時は事前に職員に連絡を取って講習を受ける

• ガスが出やすい試料、大きすぎる試料、壊れやすい試料、反応性
の高い試料など、分析室真空度を劣化させる試料は勝手に入れ
ず、事前にスタッフに相談する

• トランスファーベッセルを使用する場合、必ず施設職員に連絡し
許可を取る
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装置使用の前に

使用記録簿に名前や利用時間
等を記入。使用前の分析室真空
度をチェックして値を記入

使用後の分析室真空度のチェックと終了
時間の記入を忘れないで下さい。延長にな
る場合は予約状況を確認して予約を追加す
ること

利用時間とは装置を占有していて他の人
が使えない状況の時間です。≠分析時間

Ar⁺イオンガンのイオン化室真

空度と分析室真空度をチェック
して下さい。通常は
✓ イオン化室 ~10−4𝑃𝑎
✓ 分析室 ~10−7𝑃𝑎

著しく真空度が劣化している
場合はスタッフに連絡

イオン化室

分析室

イオンガンユニットで
Channel/float voltageボタンを押し

て点灯させ、ディスプレイに表示さ
れた番号が「７」である事を確認

イオンガンの電流電圧条件が各Channelに
入力されており、Channel番号を呼び出す事

でイオンガンが各条件に設定されます。
Channel「7」はイオンガンが使えない設定に
なっています

イオンガンユニット
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試料の準備
装置の立ち上げ前に試料をホルダー
にセットします。ホルダー類は真空デシ
ケーターに保管されています。通常の
試料であればノーマルホルダーを利用

大型試料(100mmφ以下)専用ホルダーもあります。

ガスが出やすい試料や崩れやすい試料など不安な
試料はご相談下さい

留め金やカーボンテープなどを使い、
試料をホルダーに固定。試料が完全に
固定されているのを確認して下さい

• 粉末試料を扱う場合

カーボンテープを使用するか、金属薄
膜(Al、In、Siなど)に付着(圧着)させます。
ブロアーを30回以上は吹きかけて固定

出来ていない粉末を完全に飛ばして下
さい。またホルダーに衝撃や振動を与
えて粉末をふるい落としてください。少し
でも粉末が装置内で飛び散ると故障の
原因になります

ノーマルホル
ダー(予備)

ノーマル
ホルダー

帯電試料用
ホルダー

帯電試料用
ホルダーの蓋

大型ホルダー

留め金&ネジ ホルダー固定台

2㎜以上厚みがある試
料は底板を外して固定

留め金固定は必ず両脇に。固定後はホルダーを逆
さにしてみてしっかり固定しているか確認して下さい。
X線源と留め金&試料の位置関係に注意



5

試料の準備（利用時）

・インジウム(In)箔を使った粉体埋め込み
1. 3cm角ほどのアルミホイルを2枚、In箔を

1cm角ほどのサイズで1枚切り出す
2. 3cm角のアルミホイルの上にIn箔を載せ、
スパチュラ数杯程度の粉体試料をIn箔の
上に平たく敷き詰める

3. もう一枚のアルミホイルをIn箔の上に載
せて、指先で軽く押し込む

4. 試料やIn箔がずれ込まないようにサンド

イッチしたアルミホイルを持って、プレス
機の黒い台座に載せる。

5. もう一つの台座を試料の上に載せて、台
座ごと油圧プレスで圧力をかける。（可能
な範囲で十分に）

6. プレス機の圧を緩め、試料を回収。上の
アルミホイルを破れないよう丁寧に外す

7. 必要なサイズに試料をアルミホイル、In
箔ごとカット(5～10㎜角ぐらい)

8. 試料をピンセットで摘み、振動や衝撃を
加えて圧着していない粉体を零す

9. ホルダーに試料を取り付け、ブロワーを
かけて圧着していない粉体を飛ばす

リリースバルブ

シリンダーが少し上
がったらすぐ締め直す

In箔が露出しているところは分析し

ない。試料によっては上手く圧着され
ないものもあります。ボソボソの場合
は作り直し or 固定法変更。作製後、
ホルダーに留め金 or カーボンテープ

で固定。載せる量が多すぎると真空
引きにかなり時間がかかります
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試料の準備(利用時)

・帯電試料用ホルダーについて

中和電子銃を使った帯電緩和を、試
料にバイアス電圧をかける事でより効
果的にします

試料下部に+100V印加し、GNDの蓋部と電位差を

つける事で中和電子を効率的に試料表面に当てる
事が出来ます。帯電緩和の他、Ar+イオンガンでの

エッチング時に、エッチングによる表面電位のズレ
を抑制する効果があります

写真のように試料を搭載し蓋をして
固定。試料の厚みは1.3mmが限度で

す。蓋部とホルダーの金属部が接着し
ないようにセットします。試料表面が蓋
部より出ないようにします

固定後にホルダーの蓋部と端子部の
間で導通が取れていない事を確認

導通があると蓋部に電圧をかけられないので効
果がありません

・試料の表面汚染について

空気中での表面汚染を出来るだけ防ぎたい場合、ドライプロセスで作成した試料については

作成後すぐにアルミホイルで包んだり、真空装置に保管して大気に晒さないで下さい。ウェットプ
ロセスで作成した試料についてはアセトン洗浄した後に超純水洗浄、すぐにエアーダスターなど
で十分ブローし、アルミホイルなどで包んでください

・試料のリファレンスピークについて

試料のチャージシフトの補正を行うのに、リファレンスとなるピークを試料に用意しておくと、解析
の際良いと思います(リファレンスとなるピークがないなら)。炭素を含む試料はコンタミ成分のC1s

ピークと試料由来の炭素のピークが重なってリファレンスに利用出来ない場合があるのでなおさら。
Au薄膜やAuメッシュを一緒に乗せて測定したり、試料にAuをコートしておいて一緒に測定するとか、
粉末体ならば他の化学状態が分かっている粉末を混ぜ込んだりして一緒に測定すると良いです(た
だしチャージシフトが共通しない場合があるのでスペクトルの解釈に注意)
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試料準備室への導入
ホルダーを試料準備室に導入して真
空を引きます
1. 扉のロックを外し、VENTボタンを押
して準備室を大気に戻す

2. マグネットリングを少し前にずらし
て準備室内のレールを見やすい位
置に置く

3. レールに水平にぴったりとホル
ダーを載せ、奥側にもぴったり接着

4. 試料導入棒のマグネットリングを回
して「OPEN」から「CLOSE」に変える

5. 下から覗き込んでホルダーの穴に
フックが入っているのを確認

6. マグネットリングを後退させ、扉を
閉めてロックをかけ、VENTボタンを
もう一度押して真空に引き直す
ここで失敗してると分析室に導入出来ません。必
ずホルダーがちゃんとセット出来てるか確認して下
さい

1

2

VENTボタン

どっち回しでも可

目視確認

準備室真空計

真空引きには小さな金
属板試料なら30分ほど、
粉末試料では2時間以
上かかります

真空を引く間、次頁の
装置の立ち上げを行い
ます

まだまだ引きます

スキマがない
か目視確認

マグネットリング

触らない

試料準備室

ホルダー裏
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装置の立ち上げ

始めに冷却器の電源を入れます。温度表
示を確認。次にSPECボタンとX-Rボタンを押し
て、点灯させます

冷却器の電源が必ず先です。消す時は必ず後です
X-Rボタンを押すともう一つの奥の冷却器が起動します

(音が聞こえます)。奥の冷却器が稼働してない場合、もう一
度X-Rを押し直して駆動音を確認して下さい

SPECボタン

X-Rボタン

ステージランプ、カメラ電源、カメラモニ
ター、測定用PC、PCモニターの電源を入
れます。PC立ち上げ後、デスクトップの
「SPECSURF Acquisition」をクリックしてXPS
ソフトウェアを立ち上げます

ステージランプ
カメラ電源

カメラモニター

カメラ本体は↑です
触れないで下さい

解析用ソフト

AcquireメニューからXPS
を選択し、←のウィンドウを
出す 

冷却器
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装置の立ち上げ
X線の立ち上げを行います

1. 使用するX線源の種類を決める
・Mg-Kα線

Al-Kα線より強度が4割ほど高く取れる。オージェ
ピークの出現位置がAl-Kα線より230eVほど低い

・Al-Kα線
Mg-Kα線より高エネルギー(B.E.)側が測定できる。
オージェピークの出現位置がMg-Kα線より230eVほ
ど高くなる

・モノクロX線(Al)
Mg-Kα/Al-Kα線よりエネルギー分解能が高く測定で

きる。サテライトピークが出現せず、バックグラウン
ドも低い。強度はMg-Kαの1/10ぐらいまで落ちる。
試料が平板状である必要がある

2. Mgの場合はAl/Mgボタンを点灯させ、Al
の場合は消灯。モノクロX線の場合はAl
を選び、MONO/STDボタンを押して点灯

3. 線源選択後、FILAMENTの電源をON
4. ADJつまみをゆっくり回してCURRENT表示
で3.5Aまで電流を上げる。電流を上げた
ら、5分待つ

5. ディスプレイの表示をX-RAY POWERに切
り替え、X-RAY電源をON。3kV,5mAの出
力が印加される

6. 電圧つまみを3分毎に1kVずつ上げて
10kVにする(モノクロX線の場合は12kVに
し、ここで30分待つ)

7. 電流つまみを3分毎に5mAずつ上げて
10mAにする(モノクロX線の場合は25mA) 

8. 最後にAnalyzerの電源をOnにする

アナライザー電源

モノクロX線の場合

電圧 電流
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装置の立ち上げ

測定範囲 角度絞り 視野絞り

3.0mmφ 36 36

1.0mmφ 24 12

0.7mmφ 12 10

0.2mmφ 12 8

0.03mmφ 4 1

ロックネジ
CLOSE

OPEN

SPECSURFのXPS Acquisitionから
Sourceタブを選択。X線源の種類、
電圧電流値を入力後、Statusで
「On」をクリック

Automatic Offにチェックをつけて設定すると
測定終了時にX線が自動でOffになります。測

定後しばらく放置する方は 。また出力する時
はOnをクリック

StatusがUpdateに変わったら、X
線源ユニットのAUTO/MANUボタン
を押してAUTOに切り替える

以降、X線源の設定を変更したい場合は
AUTOからMANUに戻して下さい

測定範囲の設定は左画の2つ

の絞りで切り替えます。ロックネ
ジを緩めて、測定範囲を狭める
場合はCLOSE方向、広げる場合
はOPEN方向に絞りを回して左表
の数値に合わせます。36は
OPEN方向に一周分開いて0に合
わせます

回し過ぎに注意して下さい。間違った方
向に回さないで下さい

Depth profileなど、エッチング前後の様
子を見比べる場合は1㎜φまたは0.7㎜φ
に設定する

0.7㎜φを使用する時は3㎜&1㎜ modeを
選択してください

0.2㎜φ, 0.03㎜φはかなり感度が悪いで
す。微小成分は測定できません
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分析室への導入
ステージを試料交換位置へ移動

1. ステージコントローラーのP/M
ボタンを押してMEMORYモード
に切替

2. メモリーNo.をUP,DOWNボタン
で操作し、No.SEを呼び出す

3. MOVEボタンを押してステージ
を移動
すでに試料交換位置にいるはずなので基
本的には動きませんが必ず確認して下さい

ステージへ試料導入

1. 準備室の真空が十分に引けてい
ることを確認して、V1ボタンを押し
て隔壁を開ける

2. 導入棒の黒いリングを手前に押し、
のぞき窓からステージを確認しな
がらホルダーを分析室に導入

3. 奥まで入れたらリングを回して
「OPEN」にし、黒いリングを後ろま
で一番引き抜き、もう一度V1を押
して隔壁を閉める
少しでも違和感があったら無理に入れず、ス
タッフを呼んで下さい

完全に0に
一致させる

1

2

3

ホルダーの溝にステージ
がはまります

一番奥で止まります リングを回してすっと
引き抜いて下さい

ステージコントローラー
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分析室への導入

V1バルブを閉めたら分析室真空度確認
• 5.0 × 10−6Paより高い(悪い)

試料を直ちに試料準備室に回収し、準備室で
真空引きを続けて下さい

• 5.0 × 10−6Paより低い(良い)

分析室の真空度が落ち着くまで少し様子見。
落ち着いたら次の作業へ。もし真空度が悪くなっ
て5.0 × 10−6Pa を超えたら準備室へ戻して真空
引き継続。10.0× 10−7Pa以下の真空度が理想的
です

測定位置をメモリーに登録
（MgKα/AlKα利用時のみ）

1. 測定位置へステージレバーを使って移
動。測定中心はカメラモニターの十字

2. カメラズームを使って、十字の位置でカ
メラのフォーカスが試料に合うようにZ軸
の値を調整(試料の厚み分下げる)

3. ズームを戻し、XYの位置が問題ないか
再確認

4. P/MボタンでMEMORYに切り替え、
UP,DOWNボタンで登録したいメモリー
No.を呼び出し、ENTボタンを押して登録

5. ステージレバーで次の測定
位置へ移動し、全ての分析
位置を登録する

カメラズーム

カメラ本体に触れない

ステージレバー
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モノクロX線の設定(利用時)
「装置の立ち上げ」でモノクロX線
立ち上げ後、以下3点を実施

• 分光結晶の窓を開ける

本体中央にある左画の切替器の
ロックネジを緩め、bakingから
monochromeに矢印を合わせてネ
ジを締める
• Standard X線源の位置を後退

本体後ろにある左画のツマミを、
装置背面から見て反時計回りに回
して、X線源の位置を40mmに合わ
せる
• RatemeterでステージZ軸の調整
ステージTiltを-10°まで傾かせ、
目的試料を分析位置に移動。XPS 
acquisitionウィンドウを閉じ、
Acquire→RatemeterでRatemeter
ウィンドウを立ち上げ、Centreに測

定元素のメインピーク値を入力し、
Start。ピーク強度がMaxになるス
テージZ軸の値を見つけ、その位置
をステージのメモリーNo.に登録

Pass/Ratio：50、Dwell：400、Refresh time：
400がお勧め
強度が取れない場合、Tiltを-20°まで傾け
ると取りやすいです。「Angle Resolved」の高
傾斜測定を参照してTilt制限を解除

ロックネジ

X線源位置
目盛り

後ろ側にある
ので誤って他の
パーツに触れな
いよう注意

切替器

Ratemeterウィンドウ
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Ar⁺エッチングの設定(利用時)
試料表面のコンタミネーションを削りたい場合、または深さ方向のプロ
ファイルを取る場合にAr⁺イオンガンの設定をします
モニターの十字を中心に3×3mmの範囲でエッチング出来ます

Ar+イオンガンエッチングは表面の化学状態に影響を与える場合があり、エッチングを行
いながら化学状態分析をする場合、エッチングによる影響について検証した方が良いです

試料導入後、分析室真空度が10.0×
10−7Pa以下になるまで待ちます
イオン化室の真空計でAVCボタンを
押します。左画のArガスバルブをゆっ
くり反時計回りに開きます。6時を指す
マーカーから9時方向ぐらいまでは真
空計の値がほとんど動きません
ここからさらにゆっくり7時方向ぐらい
までバルブを開けます

奥のバルブ
を回す

Arガスバルブをさらに微調整し、10.0×10-2Pa

で安定するようにします。開けていく際、真空計
の下にあるSIPゲージの針を確認し、4を超えな
いように開けてください。針が4を超える場合は
バルブを閉じ、またゆっくり開けながら10.0×10-

2Paを目指してください。少し時間を置いて、値が
上がるようなら締めて調整して下さい

 12.5 × 10−2Paを超えるとエラーになります。開け過ぎ
ないように
分析中も度々SIPゲージを確認してください。SIPゲージ

が4を超えそうな場合は分析を中断し、Arガスバルブを9

時方向まで閉めて、真空状態が良くなるのを待って再開
してください。

オートバルブコントローラーの電源をON

にします。バルブが締まり、イオン化室真
空計の値が一旦下がります

オートバルブコントローラー

Arガスバルブ

イオン化室真空計

SIPゲージ

針が4を超えない
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Ar+エッチングの設定(利用時)
Channelボタンを押してXつま

みを回し、エッチングの条件を
選びます。条件は下表の通り
です。

Etching rateはSiO2で測定したもので
す。Ch5はモノクロX線測定の時にCh1と
同じエリアでエッチング出来る仕様です

channel Ch1 Ch2 Ch3 Ch4 Ch5

Beam energy(eV) 3000 2000 1000 500 3000

Emis current(mA) 20 20 20 20 20

Gas Pressure(x10⁻²Pa) 9.0 8.5 7.7 6.6 9.0

Etching rate(nm/min) 2.9 2.9 0.7 0.15 3.8

Etching rate(nm/min) 7.5 4.4 1.6 0.3 8.5

XPS AcquisitionのExperimentタブから
Experimentを「Depth Profile」に切り替え
後、Profilingタブを選択します。Presetに
使用するchannel番号、Pressureに上記の
表の値を入力し、Setをクリック。次第にガ

スバルブが緩み、ガス圧が指定値付近で
落ち着けばAr⁺エッチングの準備は終了

(Depth profileの場合はここまでやる)

Irradiation ON/OFFボタンで

エッチングを開始出来ます。
Timer DisplayをONにするとエッ

チング経過時間がディスプレイ
に表示されます(Timer Resetを
押すと時間がリセットされます)

2026/3/18更新
最新のレート

以前のレート

9.0
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中和電子銃の設定(利用時)

導電性のない試料の場合、
光電子の放出によって試料表
面に不均一な帯電が発生して
しまう事があります。結果とし
てエネルギー値や半値幅に
影響を与えます

中和電子銃により、試料表
面に電子を供給する事で帯電
現象を緩和出来ます

粉体試料、絶縁物と導電性
試料が混ざっているという場
合、利用を推奨します

中和銃未使用 中和銃使用

ガラスサンプル

・中和電子銃利用方法

1. 中和電子銃ユニットの電
源をON

2. SELボタンを押してADJUST
の項目をFIL.に切り替え、
ADJつまみを回し、電流値
を6.0Aまで上げる

3. XPS Acquisitionウィンドウ

を閉じ、メニューの
AcquireからRatemeterを
起動させる

次ページに続きます
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中和電子銃の設定(利用時)
4. Centreに強度の高いピークのエネ
ルギー値を入力。Pass：50、Dwell：
400、Refresh time：400に設定

5. Startボタンを押し、ピーク形状を確
認(ピークが見えなければ先にワイ

ドスキャンを取ってピーク位置確
認)

6. Acc.VをON。SELボタンでADJUSTを
Acc.Vに変更後、ADJつまみを回し

て電圧値を変化させながら、
RatemeterでピークCount数が一番

大きくなる電圧値を探す（画面端で
大きくなる場合はCentre値調整して
ピークを真ん中にしてください）

7. 電圧値が見つかったらその値で固
定、Ratemeterを閉じて通常通りの
測定を行う

8. いくつかの電子銃条件(有無とか)

で軽くナロースキャンを行い、変化
を見比べて、最適な条件を決めて
ください

ピークCount数だけでなく、ピーク位置、ピー

ク半値幅も正常な値になるような電圧値を見
つける。試料ごとに適当な電圧値を見つける

・帯電試料用ホルダーを使っている場合

上記の電子銃設定を行う前に左図の
電源を起動させてホルダーに電圧を印
加させます
1. POWER ON
2. OUTPUT ON
3. CURRENTを微量流す
4. VOLTAGEを100.0Vに設定直流電源装置
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トランスファーベッセル(利用時)

✓ トランスファーベッセルを使用する
場合は必ず職員に連絡する

✓ 全ての作業を慎重に行う

✓ トランスファーベッセルに衝撃を与
えない

✓ O-リングにゴミの付着などがないこ
とを確認する

✓ ホルダーの導入に十分注意する

グローブボックス内などでホルダー
に試料固定後、トランスファーベッセ
ルにホルダー封入。ホルダー設置の
方向に注意(左図参照)。しっかりと開
閉ノブを回して締めて下さい

試料準備室のロックを外してVENT後、
扉のブランクフランジを外す

試料ホルダー

トランスファーベッセル

ここから左部分は素
手で触らないこと！

この向きでホルダーを固定

ブランクフランジ

素手で真空部分を
触らないこと！

開閉ノブ
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トランスファーベッセル(利用時)
ピンの位置を合わせてトランスファー
ベッセルを扉に装着、固定リングを回
して扉に固定。扉のロックをかけて
VENTボタンを押して真空引き

試料準備室の真空計で針が緑の範
囲に突入したら、ゆっくりと慎重に開
閉ノブを回してベッセルを開けて下さ
い。急に開けるとベッセル内の空気が
一気に試料準備室のターボポンプに
入り込みポンプが故障します。真空度
も確認しつつ慎重に開けて下さい

固定リング

真空引きの際、少しベッセ
ル本体を押し込んで下さい

開けるの中断。戻してじんわり開けましょう

ベッセル内の真空が引けたら開閉ノブを全
開にします。黒いリングを操作してホルダー
を受け取り、ベッセルを閉めます(完全には閉めず、

ちょっとだけ口を開けとく)。試料準備室の真空が十
分に引けたらV1を開けて分析室にホルダー
を導入。V1を閉める。
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Wide scan

測定法は全部で6種類あります。どの
測定を行う場合でもまずはWide scan
で測定しておくと良いでしょう
ExperimentでWide scanを選択

現在のステージ位置で測定する場合
はMovementでNoneを選択、ステージコ

ントローラーのメモリー機能を使う場合
はMemoryを選択

Lens Modeに設定した測定範囲を選択

Stageタブで連続測定するメモリー番
号の始めの番号(First)と終わりの番号
(Last)を入力(Memory選択時)

RegionsタブでWide scanの各条件を
設定

Pass(eV)はエネルギー分解能と強度に関わります。

値を小さくすれば分解能が上がり、強度が下がりま
す。大体5eV程が限界です。Step(eV)間隔はPass(eV)
の1/100程に設定すると良いです。Scansは測定して

みて調整します。定性ならばバックグラウンドノイズ
の3倍、定量ならば10倍、ピーク強度が取れるように
設定します。Scan回数の1/√Nでバックグラウンドノイ
ズは減少します。

Wide scanの推奨条件は Start：Mg-Ka線では
1200eV、Al-Ka線では1400eV、Finish：0eVまたは-
10eV。Step：1.0eV、Dwell：100ms、Pass：50eV、
Scans：1～4回 です

Startボタンで測定開始します。
Checkボタンを押すと測定予測
時間が表示されます
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Markerの付け方

Wide scanを取ったらマーカーをつ

けてピークの同定をします。左画の
アイコンをクリック

スペクトル上にラインが現れます。ピー
クにドラッグして当てるとSuggested Peaks

に想定される元素一覧が表示されます。
Elementから元素を選択してAddを押すと

元素名がスタンプされます。元素によっ
てはChemical Shiftの一覧も載っており、
これもスタンプ出来ます。最後にOKをク
リックするとスタンプが残ります

Displayのチェックボックスで表示を各種変更出来ます

XPSハンドブックアイコンで標準試料のス
ペクトルを見る事が出来るので参考に
スペクトルには光電子ピークではないものが映り込みます。間
違って同定してしまわないように気をつけて下さい。サテライト
ピーク、オージェピーク、スピン軌道相互作用による分裂など。特
にK-α₃,₄に由来するサテライトが光電子ピークより10eV低い位置
に出現します。他には、Mg-Kα使用時には、大きなピークの730eV
高い位置にO-Kα由来、320eV高い位置にCu-Lα由来、230eV低い
位置にAl-Kα由来の小さなピークが見える事があります(ゴースト
ピーク)が、偽物のピークなので無視してください。Al-Kα使用時も
+230eV(Mg-Ka)、+960eV(O-Ka)、560eV(Cu-La)に注意。また、近く
に置いた別試料のピークが映る事もあります
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Narrow scan
Wide scan後、定量や化学状態分析の

為、分解能の高いモードで各元素のメイ
ンピーク付近のスペクトルを取得します。
ExperimentでNarrow scanを選択します

Movement, Lens Modeは「Wide scan」を参照

Stageタブでメモリー番号をセットします
(Memory使用時、「Wide scan」参照)。試

料によって測定内容が違う場合はここで
試料のグループ化を行えます。Groups
にグループ名を入力後Addをクリック。
First, Lastに1組の番号を入力し、Group
から名前を選択します

Comment欄に情報を入れとくと便利です。
左画はメモリーNo.1、2がCrグループ、No.3、4がPET
グループと登録されています。

RegionsタブでGroupを選択し
(Group登録時)、測定する元素を
Elementから選択します

Wide scanスペクトルを開き、

左画のアイコンをクリックすると、
スペクトル上にStartライン(緑)と
Finishライン(赤)が表示されます。

ピークに合わせてライン位置を
調整すると、測定範囲の条件に
反映されます

全てのWide scanで確認しましょう

残りの項目も適当に設定し
ます(次頁の推奨条件参照)
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Narrow scan

測定中、経過をAcquisition Statusで確
認出来ます。Pauseを押すとscan1巡後
に測定が中断され、左画のようにScans

回数だけ変更出来るようになります。変
更後Continueをクリックすると測定が再
開されます

Stopを押すとscan1巡後で測定終了になります。
Abortは強制終了

・スペクトルウィンドウについて
カーソルをスペクトル上に置くとウィンドウ右下にエネルギー位置と
強度が表示されます。左上には表示スケールの調整ボタンがありま
す。一度の測定で得たスペクトルは一つのウィンドウに格納されてい
ます。各sample、各Region、各Levelはウィンドウ右上のメニューから
表示を変更出来ます
データのSave, Openなどもウィンドウ単位。Memory番号、出力した
データの表記番号が1番からに対し、表示上のsample番号は0番か
ら付けられます。間違わないで

・Narrow scanの推奨条件
Start & Finish：目的のピークの周囲±10eV以上。スピン分裂して
いるregionでは出来れば全てのピークを取るべし。必ずサンプル
間で全て測定出来る範囲か確認すること
Step：0.1eVか0.05eV、オージェピークは0.2eVでも良い
Dwell：100ms
Pass：10eVか5eV。微小成分の測定が目的でピーク強度がどうし
ても取れない場合は20eVに設定し、StepとDwellも0.2eVと200ms
に設定する。半値幅は10eV時より2割ほど悪くなるが感度は4倍
ほど高くなる。相対定量計算をする場合、PassとDwellは統一して
ある必要がある
Scans：10～100回。20eV幅を0.1eVstepで100回測定すると35分く
らいかかる
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Depth Profile
Depth ProfileではAr⁺エッチングと

測定を交互に繰り返す事によって、
試料の深さ方向のプロファイルを取
得出来ます

ExperimentでDepth Profileを選択

し、イオンガンのガス圧調整を行う
(「Ar+エッチングの調整」を参照)

Acquisition ModeでFullを選択
Separate(PB別法)とSimultaneous(PB同時法)
を選択するとPeakとBackgroundのエネルギー

位置を指定してその差分強度だけを取得しま
す。スペクトルを取得しない分、高速で測定が
出来ます。元素のピーク強度プロファイルだけ
取れればいい場合に使えます(「Image & 
Linescan」参照)

Profilingタブでエッチング回数と時
間の設定を行います

左画では1回目(levelという単位)の測定前に0
秒、2回目~4回目の測定前に各15秒、5回目
~10回目の測定前に各60秒ずつエッチングを
行うようになっています

あとの設定は「Narrow scan」と同
様です。補足として、

・Arガス圧の設定を行ってからガス圧が上がる
のを待って測定を始める
・SourceタブではStatusでAutomatic OFFを推奨

・アトミックミキシング、選択スパッタリング等を
考慮した解析が必要な場合があります
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Angle Resolved

Angle ResolvedではステージのTilt

をアナライザー軸に対して徐々に傾
けながらスペクトルを取得して、非破
壊で試料の深さ方向のプロファイル
を取得出来ます

高傾斜測定をしたい場合、以下の
設定をします

最大80°まで傾けられるので平均分析深さ
6nmから1nmぐらいまでのプロファイルを取得出
来ます
高傾斜にする事で測定する表面の領域がY方

向に伸び、信号量を増やす事も出来ます。微小
量分析に向いてます

ステージを大きく動かす分析なので十分に気
を付けて下さい。事前にスタッフにご相談下さい

分析後は必ずハード・ソフト共に設定を元に戻
して下さい

このモードで測定する際はステージのメモリー
登録をClearボタンで最後に消去して下さい

・XPS本体での設定

試料を分析室に導入。傾ける
ので必ずホルダーに試料をしっ
かり固定する。ロックネジを外し、

磁場レンズステージのマイクロ
メーターを回し、Z=17.95から
Z=8.5付近まで下げる。下部に

あるスイッチが押されるのを確
認する(小さくカチッと音がしま
す。回し過ぎると壊れます)。外
したロックネジを再び締める

磁場レンズステージ

磁場レンズ

スイッチ

マイクロメーター

ロックネジ
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Angle Resolved
・Spec Surfでの設定

View→ConfigurationからSystem 
Configurationダイアログを立ち上げ
て、Sample HolderでHigh Angleを選
択します。Tilt制限が解除され、-
30°から80°まで動かせるように

なります。以降、十分に注意してス
テージ操作して下さい

高傾斜測定の前に傾斜なしでWide scanは
測定しておきましょう

ExperimentタブでAngle Resolved
を選択し、Profilingタブでステージ

の傾ける角度の設定を行います。
左画の設定だと0°から80°まで
5°ずつ傾けながら各レベルのスペ

クトルを取得します。残りの設定は
「Wide Scan」、「Narrow Scan」を参
照
マイナス方向に10度以上に傾け
る場合、X線源の位置を必ず後方に

下げる(「モノクロX線の設定」参照)

←マイナス方向に傾け
るとX線源にぶつかる恐

れがあるので、基本禁止
です。スタッフにご相談
下さい

Configuration



27

Total Reflection
Total ReflectionではモノクロX線を使
用し、X線の全反射が起こるようにス

テージの位置関係を調整する事で、
通常の測定深さから約2/3浅く、また
S/N比良くスペクトルを取得出来ます。

主に試料表面の汚染物質の評価に
利用出来ます

平滑な表面を持つ試料(Siウェハーなど)でなけ
れば測定出来ません

・Total Reflection測定方法

1. 試料表面がステージと平行になる
ようホルダーに設置、試料導入

2. モノクロX線を立ち上げ、Ratemeter

で試料の光電子スペクトルを確認
しながらZ位置を調整します(「モノク
ロX線の設定」参照)

3. EｘperimentでTotal Reflectionを選
び、Tiltを-10°から-5°まで0.2°

ずつ傾けて適当にスペクトルを取
得、S/N比の傾向を確認

4. -4°から‐1°まで1°ずつ
Ratemeterでスペクトルを確認しな
がら、強度が出るよう再度Zの調整
(追い込み)をします

5. Zの調整が終われば-1°でスペクト
ル測定を行います
試料やホルダーが少し傾いていると-1°で測定
出来ません。S/N比が良い適当な傾きをRatemeter
で見つけて測定を行って下さい

Wide   BE (eV)
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20140328_133719_Wide_
20140328_132916_Wide_

青：通常測定 赤：全反射X線測定
BackgroundでGainを合わせると、コン
タミネーションのCのピーク強度が2倍
ほど大きくなっているのが分かる

C1s

O1s

Si2p

O 1s  BE (eV)
540 536 532 528 524
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工程3を飛ばしてもそんなに問題あ
りません
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Image & Linescan
Imageでは最大5.0×1.8cmの元

素マッピング像を取得出来ます。
ケミカルシフトを利用すれば化学
状態の違いをマッピング出来ます

まず事前に取りたい元素の
Narrow scanを取得しておきます

ExperimentでImageを選択し、
Acquisition ModeでSeparate(PB別
法、設定が楽)かSimultaneous(PB
同時法、測定が速い)を選択します

・Separate(PB別法)
Regionsタブで取得したNarrow 

scanのスペクトルを元に、Peak、
Bk1、Bk2の値を設定します

Bk1は低エネルギー側バックグラウンド、
Bk2は高エネルギー側バックグラウンドに合
わせます。ここではSiO2由来のSiピークと
metal-Si由来のSiピークに対してPeak,Bk1,Bk2
を設定しています

・Simultaneous(PB同時法)
Channels欄をクリックし、各

Channel(検出器)で取得する強度を
BackgroundにするかPeakにするか
選択します。Range値(全検出器で
測定出来るエネルギー幅)が測定

したい元素の高エネルギー側
Background,Peak,低エネルギー側
Backgroundを抑え込めるように
Pass値を適当に変更します

PB別法

PB同時法
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ステージコントローラーでimage像

を取得したい試料の範囲の、左上
のステージ位置をmemoryNo.1に、

右下のステージ位置を
memoryNo.2に記録させます

No.1

No.2

マッピング
領域

ImageタブでReadボタ

ンをクリックし、メモリー
位置を読み込みます。
Scan ではSizeかStepか

選択し、像の解像度を
決定します。Modeでは
Imageを選択します←マッピング結果の各

元素の画像を色分けし
て重ねる事も出来ます

左図は赤:Si 青:Auの広域
マッピング結果です

Image & Linescan

ModeでLinescanを
選ぶとNo.1から
No.2の位置までの
線分析を行います

Siピーク
(SiO2)

Siピーク
(metal-Si)

←Simultaneous(PB同時法)で
のLinescan結果

これはSiウェハーの真ん中をAr⁺エッ

チングした試料の分析で、削った位
置でSi、周囲でSiO₂の分布が得られて
います

Si(SiO2)

Si(metal-Si)
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データの基本的な処理
測定したスペクトルデータは全
て自動で日付・測定法・線源で名
前が記されてAuto Storageフォル
ダに保存されます

File→OpenからAuto Storageフォルダを選

択し、データを選択するとウィンドウ下部に
データの詳細が表示されます

スペクトルを別の形式で保存す
る場合はFile→Save asでファイル
の種類を選択して下さい

SpecSurfデータの他、テキスト形式と
VAMAS形式が出力出来ます。ARIM利用申
請でデータ提供有の利用者はVAMAS形式

を必ず保存して持ち帰ってください。データ
アップロードに使用します

File→Reportでスペクトルをレ

ポート形式で画像として出力出来
ます。定量計算結果や波形分離
結果もレポートにまとめることが
出来ます
データをXPS-PC上で個別に管理

しておきたい場合はデスクトップ
にある「data」フォルダ下に研究室

単位でまとめて保存するようにし
て下さい

基本的にデータの管理は各自で行って下
さい。データ保存については保障しません

Title      : 20241112_152022_Narrow_AlKa_cc_bs.ssf
Date       : 火曜日, 11月 12, 2024
Operator   : XPS User
Institute  : UnKnown
Technique  : XPS
Source     : x-ray (AlKa)
Lens Mode  : DHA : Preset No.0
Experiment : Narrow scan
Movement   : Memory
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Element Region Start (eV) Finish (eV) Step (eV) Dwell (ms) Pass (eV) Scans
O 1s 539.463 524.463 0.100 100 10 20
Ca 2p3/2 357.463 341.463 0.100 100 10 20
C 1s 293.463 278.463 0.100 100 10 20
Si 2p3/2 107.463 93.463 0.100 100 10 30

Element State Label Sensitivity Intensity (cps) Atomic %
O 1s O 1s 11.9121 23743.40 59.42
Ca 2p3/2 Ca 2p3/2 21.1321 13182.72 18.60
C 1s C 1s 4.2584 688.43 4.82
Si 2p3/2 Si 2p3/2 3.5266 2029.57 17.16

Co 2p3/2  BE (eV)
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Energy Intensity Width/2 Area Ratio
780.83 70.0057 1.80713 279.896 71.7748
785.262 22.2201 1.21626 60.1004 15.4118
787.556 16.5581 1.35822 49.9675 12.8134
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終了の手続き
・帯電試料用ホルダーを使用した場合

電圧・電流値を0にする
OUTPUT OFF
POWER OFF

・中和電子銃を使用した場合
電圧・電流値を0にする
Acc.V OFF
電源 OFF

・Ar+イオンガンを使用した場合
オートバルブコントローラー OFF
Arガスバルブを時計回りに9時方向(1/4回転)ぐらいまで閉める
3分待つ
Arガスバルブを時計回りに6時方向(3/4回転)まで閉める
イオン化室真空計のAVC OFF
イオンガンユニットでTimer Displayを選び、Timer resetボタンを押す
イオンガンユニットでChannelを選び、Xつまみを回して「7」に戻す

・Angle Resolved測定を行った場合
ステージを試料交換位置に移動
X線源の位置を元に戻す(ずらした場合)
磁場レンズのZ軸をZ=17.95に戻し、ロックネジを締め直す。
Configurationダイアログのholder設定をStandardに戻す
ステージメモリーに登録した位置情報を全部消去

・モノクロX線を使用した(Total Reflection測定を行った)場合
ステージを試料交換位置に移動
X線源の位置を元に戻す
分光結晶の窓を閉め(Bakingに合わせる)、ロックネジを締める
次ページの「X線源を落とす」作業後、15分経過したらMONO/STDボタンを
押してSTDに戻す
Tiltを-10度より上に傾けている場合、
「Angle Resolved測定を行った場合」の手順を実行する

・トランスファーベッセルを使用した場合
ホルダーを試料準備室に回収後、ベッセルにホルダーを再封入
扉ロックを外してVENT。VENT後、ベッセルを外してブランクフランジをつける
扉をロックし、試料準備室の真空引きを行う。
問題なく真空が引けているか確認する。サンプルを回収し、ベッセル返却

まず初めに、下記ケースに応じて終了手順を
進めて下さい。順番を必ず守って下さい
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終了の手続き

・X線を落とす
Auto/ManuボタンでManualに変更
X-RAYの電流を最小値に、電圧を最小値にする
X-RAY電源をOFF
Displayの表示をFILAMENT POWERに変更
FILAMENTのADJつまみを回して電流を0にする
FILAMENT電源をOFF
SpecSurfのXPS acquisitionのSourceタブでOffをクリック

・試料の取り出し
ステージコントローラーのP/MボタンでMEMORY表示に変更
UP, DOWNボタンでNo.SEを表示させる
MOVEボタンを押し、試料交換位置へ移動
V1ボタンを押してV1バルブを開ける
試料交換棒の黒いリングをOPENの状態にして前方に押し出す
黒いリングを回してCLOSEにする
黒いリングを一番後方まで引き、試料を試料交換室に回収
V1ボタンを再度押してV1バルブを閉める
試料交換室のロックを開ける
VENTボタンを押して交換室を大気に開放
黒いリングを回してOPENにする、ホルダーを回収
試料交換室のロックして、VENTボタンを押し、真空に引く

・XPS装置本体の終了＆その他の作業
ホルダーから試料を回収。ホルダーは洗浄後、真空デシケーターに入れ
て真空を引く。作業台を片付ける
アナライザー電源 HTをOFF
カメラ、カメラモニタ、ステージランプをOFF
研究室USBメモリで測定データを解析用PCに移動
Spec Surfを閉じ、PCシャットダウン。ディスプレイOFF
X線源を落としてから15分経過後、(モノクロX線利用時、MONO/STDをSTD
に切り替えてから)X-R、SPECボタンをOFF
冷却器の電源をOFF
分析室真空度をチェック、終了時間と共に使用記録簿に記入
他の装置使用者などがいない場合は研究室の照明を落とし、施錠を行う

全ての測定で共通の手続きです。順番を必ず守って下さい
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Q & A
基本的にスタッフにお尋ねください

• V1ボタンを押してもV1が開かない
→試料導入棒の黒いリングを一番後ろに下げてください。窒素ボンベの2
次圧が0になっている場合はボンベ交換が必要なのでスタッフまでご連
絡ください。

• 真空引きが全然進まない。真空度が悪い
→試料準備室の扉のOリングなどにゴミが付着してないか確認。試料の

問題であればまずは試料の数、体積を可能な限り減らしてください。加
熱が可能なら加熱して水分などを出しきってから導入してください。真空
度が達しないものは待つしかありません。なるべく乾燥のための下準備
を済ませてください。

• 測定を始めても全く信号が取れない
→HTボタンを確認。または測定範囲設定の絞りの数値を確認。またはX
線源のmonochro/standardボタンの状況を確認。X線源で間違った線源
を設定している場合は一度X線を落とし、15分待ってから正しい線源を立
ち上げ直す。

• 目的元素のピーク強度が弱すぎてナロー測定が出来なそう
→サンプルの見直し、サンプル固定法の見直し(In箔埋め込み)、分析位
置の見直し、ピーク位置の確認。測定条件でpass, dwell, stepをそれぞれ
20eV, 200ms, 0.2eVに設定して、scansをなるべく増やして測定してくださ
い。ただしエネルギー分解能は落ちます。

• Arガスバルブを開けた際、真空計にP-Hというエラー表示が出た
→開けすぎです。オートバルブコントローラーをOFFにし、Arガスバルブを
時計回りに1回転させて最初の状態に戻してください。Ａｒイオンガンの真
空計で「MEAS」ボタンを押すとエラーが消えます。その後、「FIL ON」ボタ
ンを押すと表示が復帰します。今度はゆっくり慎重にArガスバルブを開
けてください。

• 正体が良く分からないピークが出ている。スペクトル形状が変
→コンタミネーションに関わる可能性がなければ、中和電子銃を試してく
ださい。帯電の影響かもしれません。また、X線源の種類を変えて測定し

直してみてください。ピークが消えたらオージェピークまたはゴーストピー
クに由来している可能性があります
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